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Come esportare un PDF per la stampa



Lorenzo Miglietta

8 Luglio 2016






Quando si prepara un file per la stampa, un aspetto spesso sottovalutato ma in realtà molto importante, è l’esportazione del file. In particolare quando si va ad esportare un pdf per la stampa.
Vuoi sapere come si esporta correttamente un pdf? In che modo puoi far sì che la resa di stampa sia la migliore possibile? Ok, allora questo è l’articolo giusto per te!
Questo articolo è il terzo di una serie di 3 articoli dedicati alla preparazione di un file alla stampa, il primo articolo era dedicato alle basi, con consigli pratici per preparare un file alla stampa, mentre il secondo era dedicato a come gestire i colori di un file che deve essere stampato.
Ti consiglio di leggere o di dare un’occhiata anche a questi due articoli prima di leggere questo (se invece sei solo interessato a come esportare un pdf per la stampa nel modo migliore, continua a leggere!):
	Come preparare un file alla stampa (la guida per designer) 
	Come gestire i colori di un file per la stampa

In questo articolo infatti, ti spiegherò come esportare un pdf nel modo migliore! Beh, in realtà non sarò io a spiegartelo ma sarà Mauro Lussignoli, l’autore del secondo articolo di questa serie, esperto di stampa e prestampa e autore anche di Artigrafiche.
Lascio quindi la parola a Mauro. Sei pronto per cominciare?
Iniziamo con un po’ di informazioni di base partendo da una domanda che, pur sembrando banale, in realtà non lo è per niente: che cos’è un pdf?
Cos’è un pdf?



Wikipedia recita: “Il Portable Document Format, comunemente abbreviato PDF, è un formato di file basato su un linguaggio di descrizione di pagina sviluppato da Adobe Systems nel 1993 per rappresentare documenti in modo indipendente dall’hardware e dal software utilizzati per generarli o per visualizzarli.“
Un file PDF può descrivere documenti che contengono testo ed immagini in qualsiasi risoluzione.
Ogni documento PDF contiene una completa descrizione del documento composta da proprietà (Titolo, Autore, ecc.) testo, stili di carattere (font), immagini e oggetti di grafica vettoriale che compongono il documento.
Un PDF può quindi contenere molti tipi di informazioni diverse che, non per forza, sono adatte in qualsiasi caso alla stampa.
Bisogna quindi andare a capire quando un PDF diventa un file capace di trasportare queste informazioni dal file sorgente (ad esempio il vettoriale di Illustrator) alla stampa senza errori o mancanze.
Proprio per questo il formato di file PDF è stato standardizzato nel 2007 con norme ISO (quelle norme internazionali che regolano, tramite standard, le cose più disparate, in alcuni casi anche i formati dei file).
Il formato di file è stato standardizzato e suddiviso in una serie di “sottoformati” dedicati ai vari campi primari di utilizzo di un PDF: archiviazione, documentazione ingegneristica, settore sanitario, accessibilità e prestampa.
Quello che interessa noi è ovviamente quello dedicato alla gestione della fase di prestampa, chiamato PDF/X, la cui norma ISO più recente è la ISO 15930-7:2008, chiamato PDF/X-4.
Queste sono tutte le varie norme del formato PDF/X (non stare a leggerle tutte, lo scrivo solo per completezza di informazioni, in realtà, come vedrai dopo, non ti serve conoscerle a memoria!):
	ISO 15930-1:2001: PDF/X-1a:2001, consente solo l’uso di CMYK + tinte piatte, basato sulle specifiche PDF 1.3
	ISO 15930-2: PDF/X-2, mai pubblicato
	ISO 15930-3:2002: PDF/X-3:2002, consente l’uso di CMYK, Spot, Calibrated (managed) RGB, CIELAB, con profili ICC, basato sulle specifiche PDF 1.3
	ISO 15930-4:2003: PDF/X-1a:2003, revisione di PDF/X-1a:2001, basato sulle specifiche PDF 1.4
	ISO 15930-5: PDF/X-2, un estensione di PDF/X-3 che permette l’uso di inclusione delle immagini in stile OPI, fu ritirato nel 2011
	ISO 15930-6:2003: PDF/X-3:2003, revisione di PDF/X-3:2002 basato sulle specifiche PDF 1.4
	ISO 15930-7:2008: PDF/X-4, include la gestione colore, sono supportati CMYK, grigi, RGB o tinte piatte, così come la trasparenza ed i contenuti opzionali, basato sulle specifiche PDF 1.4

“Mi gira la testa!!! In questo marasma di sigle, numeri e standard ISO … come accidenti posso fare per non commettere errori?”
Dopo aver letto quanto fin qui spiegato, sembra che gli standard, i vari formati PDF/X e le norme ISO non ci aiutino… anzi, ci portino solo una gran confusione in testa.
Tranquillo!
Ho voluto fare questa introduzione al formato PDF per chiarire in modo inequivocabile che:
	Il PDF in quanto tale non è necessariamente uno standard adatto alla stampa, fatto salvo l’uso dei sotto-formati PDF/X specifici
	Non devi sapere a memoria tutte le specifiche dei formati PDF/X di cui sopra, ma…
	Devi aver chiaro il concetto che quei formati nascono e sono stati ideati per agevolare il lavoro quotidiano, in quanto le loro specifiche non permettono l’uso di contenuti incompatibili con il processo di stampa.
Ad esempio se si cerca di esportare un documento contenente immagini RGB, usando come formato il PDF/X-1a, questa operazione risulterà sicuramente in un errore di creazione del file.

“OK… meno male, questo mi rassicura. Ma allora quale formato devo scegliere?”
Qui ci viene in aiuto una roba chiamata GWG. Adesso ti spiego tutto!
Quelli che hanno già fatto il lavoro sporco: GWG
Il Ghent Work Group, anche noto come GWG, è un gruppo internazionale di associazioni di utenti, venditori di programmi, insegnanti ed utenti finali del mondo della stampa e della grafica.
L’obbiettivo di questo gruppo è stabilire e diffondere il più possibile delle linee guida ideate espressamente per il mondo del graphic design.
“Ok, sta solfa per dirmi che cosa?”
Per dirti che dal 2002, GWG, ha creato e e diffuso gratuitamente diverse linee guida e specifiche per la creazione di documenti PDF orientati alla stampa. Le specifiche GWG si basano sugli standard ISO (PDF/X) e sono utilizzabili nei più diffusi software grafici oggi presenti sul mercato.
“Grande! Quindi se devo esportare un documento pronto per la stampa in formato PDF, non mi devo inventare nulla… qualcuno ha già fatto il lavoro sporco per me!”
Si e no…
Si nel senso che GWG ha già fatto il lavoro sporco per te!
No, nel senso che tu devi essere in grado di capire il lavoro sporco che GWG ha fatto proprio per te! …e non usare un preset a caso fra i molti disponibili!
Esportare secondo le specifiche: che vantaggi porta?
Esportare usando uno standard già definito da un ente terzo (GWG) ti porta questi vantaggi:
	L’uso di uno standard è il primo livello di controllo sui contenuti del tuo documento PDF. Se il tuo documento PDF non supera questo primo filtro, significa che “è fuori standard” quindi, molto probabilmente, potrebbe causare seri disguidi in fase di lavorazione
	Non ti devi inventare nulla, devi solo avere la pazienza di capire cosa siano gli standard, quale sia il migliore per il tuo progetto grafico e sceglierlo in accordo con lo stampatore
	L’uso degli standard riduce al minimo la possibilità di contestazioni dovute ad errori presenti nel file inviato in lavorazione

Ricevere uno standard già definito da un ente terzo (GWG) porta allo stampatore questi vantaggi:
	L’uso di uno standard è il primo livello di controllo sui contenuti del documento PDF. Sapere di ricevere un PDF in un formato che aderisce allo standard scelto in comune accordo col proprio fornitore, dà maggiori garanzie di non incorrere in disguidi in fase di lavorazione
	Lo stampatore non si deve inventare nulla, deve solo scegliere in comune accordo con il fornitore lo standard da utilizzare
	L’uso degli standard riduce al minimo la possibilità di contestazioni dovute ad errori presenti nel file ricevuto

Perché può non bastare lo standard PDF/X?
Il punto è che gli standard ISO PDF/X sono standard che vanno benissimo per quello che è il loro obbiettivo, ossia “Creare dei documenti PDF adatti alla stampa”.
Ed è proprio qui il punto. Quei PDF sono adatti alla stampa, ossia non creeranno errori in fase di rasterizzazione e stampa, ma nessuno ci garantisce che siano ottimizzati per quella specifica tecnologia di stampa.
Ok, provo a spiegarlo con un esempio pratico.
Se nel documento PDF si inserisce un’immagine CMYK a 100ppi, le specifiche PDF/X, non riporteranno alcun tipo di errore in quanto l’immagine è nello spazio colore adeguato per la stampa.
Ma, a ben guardare, quella risoluzione potrà andare bene per una certa tecnologia di stampa (magari una stampante inkjet da scrivania) e non per un’altra (ad esempio una macchina da stampa offset a 150lpi).
Le specifiche presenti nei preset GWG (e non nello standard ISO) sono infatti relative alla tecnologia di stampa scelta, per risolvere questi aspetti.
GWG ha semplicemente classificato una serie di tecnologie di stampa ed ha creato i preset da utilizzare sia per la creazione che per il controllo dei documenti PDF/X.
Ok, ma ora basta parlare in modo generico, andiamo nel dettaglio: come si sfruttano queste classificazioni, questi strumenti? Come si esporta un PDF seguendo le specifiche GWG? E che specifiche GWG devo seguire?
Istruzioni pratiche per esportare un PDF secondo le specifiche GWG
1. Quali sono le specifiche GWG e dove si trovano?
Siamo arrivati al momento clou nella scelta dello standard! Per spiegare nel dettaglio quale sia lo standard migliore da usare per un progetto grafico, GWG ha preparato un documento da leggere attentamente e seguire, questo. Se invece lavorate nel settore del packaging, il documento da leggere è questo.
In questi documenti vengono spiegati nel dettaglio i requisiti che un documento PDF deve avere per essere conforme alle specifiche GWG. Queste specifiche si basano sugli standard ISO PDF/X e definiscono anche quei dettagli specifici per ogni singola tipologia di stampa. Ognuna di queste specifiche (o preset) viene chiamata “Variante”.
L’uso della variante da utilizzare è facilmente intuibile dal nome assegnato alla variante stessa.
Elenco varianti GWG:
	GWG_MagazineAds_2015 CMYK
	GWG_MagazineAds_2015 CMYK + RGB
	GWG_NewspaperAds_2015 CMYK
	GWG_NewspaperAds_2015 CMYK + RGB
	GWG_SheetCmyk_2015 CMYK
	GWG_SheetCmyk_2015 CMYK + RGB
	GWG_SheetSpot_2015 CMYK
	GWG_SheetSpot_2015 CMYK + RGB
	GWG_WebCmyk_2015 CMYK
	GWG_WebCmyk_2015 CMYK + RGB
	GWG_WebSpot_2015 CMYK
	GWG_WebSpot_2015 CMYK + RGB
	GWG_WebCmykNews_2015 CMYK
	GWG_WebCmykNews_2015 CMYK + RGB
	GWG_PackagingOffset_2015
	GWG_PackagingGravure_2015
	GWG_PackagingFlexo_2015

Nel dubbio chiarite sempre lo standard da utilizzare in comune accordo col vostro stampatore di fiducia.
2. Come si fa a seguire le specifiche GWG? E come si impostano?
Quando esporti un progetto grafico, dal menù File -> Esporta -> Adobe PDF (stampa), in formato PDF, nella finestra seguente, puoi impostare tutti i settaggi che preferisci manualmente (operazione vivamente sconsigliata).



Attenzione! Le impostazioni di default di questa finestra non sono la soluzione migliore per i tuoi lavori. Gli standard PDF vanno sempre configurati in base alle esigenze produttive. La frase “Ma io non ho toccato niente!” non ti giustifica agli occhi del cliente.
Oppure si possono scegliere i presets (le varianti) preesistenti scegliendoli dall’apposito menù a tendina.



Ovviamente in questo menu a tendina non ci sono le varianti di GWG ma si trovano soltanto gli standard PDF/X.
Se vuoi entrare nel mondo dei professionisti ed utilizzare gli standard GWG, infatti, dovrai scaricarli dal sito ufficiale, qui: gwg.org/application-settings.
In questa pagina è possibile cercare e scaricare le impostazioni GWG per un’infinità di programmi di grafica. Basta indicare il nome del software che si sta utilizzando e fare cerca (Search).



Nella pagina risultante bisogna poi scegliere il preset desiderato e premere su Download per scaricare le impostazioni volute (in questo esempio userò la variante SheetSpotHiRes_1v4).



Nota: il file ZIP scaricato solitamente conterrà anche una cartella chiamata “Documentation” contenente le istruzioni necessarie all’installazione delle impostazioni nel programma scelto.
Per installare i preset “SheetSpotHiRes_1v4” in InDesign, basta seguire questi 3 semplici passi:
	Aprire InDesign
	Menù File -> Predefiniti Adobe PDF -> Definisci
	Premere su Carica, scegliere il file con estensione .joboptions (che avete appena scaricato) e terminare l’operazione premendo “Apri”.

Avrai così caricato il preset “SheetSpotHiRes_1v4”.



Ora sarai in grado di esportare il tuo progetto grafico utilizzando il preset definito da GWG.
3. Dove e come verificare se il PDF è stato esportato secondo gli standard?
Ok, dopo aver appreso chili e chili di teoria, ed aver speso ore per produrre un PDF/X professionale, beh, ora come verificare che sia veramente fedele alle specifiche scelte?
In questo, il software Acrobat è il più fedele alleato! Ecco come verificare che un PDF aderisca alle specifiche scelte in 4 semplici passi:
	Aprite in Acrobat Professional il PDF da voi creato.
	Andare sullo strumento Preflight (a seconda delle versioni vi si accede in modo diverso, in quelle più vecchie da Menu Edit -> Preflight, mentre nelle versioni CC più recenti dal pulsante dei Tools “Print Production” e poi, dal menu a comparsa laterale a destra si seleziona “Preflight”

	Scegli il tipo di Preflight da utilizzare per verificare il contenuto del documento PDF

	Verificare eventuali messaggi d’errore

Se in fase di Preflight si riscontrano degli errori, il problema non è delle specifiche che si stanno utilizzando ma, molto probabilmente, il problema è nel documento.
Cerca di correggere il problema all’origine (magari guardando il tipo di errore e facendo una ricerca su Google) e riprova ad esportare il PDF secondo le specifiche scelte.
Ricordati di fare sempre la verifica con lo strumento Preflight per documenti importanti per evitare errori in fase di stampa.
Consiglio finale: chiedi una cianografica per i lavori più importanti
Ultimo passo, ma per questo non meno importante. Dopo aver mandato i file allo stampatore, chiedigli sempre di fornire la cianografica del lavoro che andrà in macchina da stampa.
La cianografica è un documento di stampa a bassa qualità che viene rilasciata dal tipografo in fase di prestampa per permettere al designer che si è occupato dell’impaginato di fare un controllo generale prima di andare in stampa.
Osservala attentamente e firmala solo se concordi con il risultato ottenuto. La verifica della cianografica ti permetterà infatti di prevenire eventuali errori o sviste.
La cianografica deve essere fornita dallo stesso stampatore e da te puntigliosamente certificata. Sarà compito dello stampatore assicurarti che la stampa rispecchi quando visto ed approvato nella cianografica.
Conclusioni
Ok, questo articolo è concluso! Prima di ridare la parola a Lorenzo ti faccio una breve checklist con tutte le cose da fare per esportare un PDF per la stampa nel modo più professionale possibile:
	Scegliere con precisione gli standard da seguire, in comune accordo con lo stampatore!
	Applicare gli standard, ed esportare in PDF seguendo gli standard
	Chiedere sempre la cianografica del lavoro
	Se tutto quadra, buona stampa!

Grazie Mauro! Eccomi, sono di nuovo Lorenzo! Devo dire che questo è un articolo che ci voleva davvero qui su Grafigata e sono contento di averlo pubblicato!
Ti ricordo, se ancora non lo hai fatto, di andarti a leggere (e mettere tra i preferiti) gli altri due articoli della serie di Grafigata su come preparare un file alla stampa:
	Come preparare un file alla stampa (la guida per designer) 
	Come gestire i colori di un file per la stampa
	L’articolo che hai appena finito di leggere :)

Ti consiglio anche di andare a leggere i molti articoli e approfondimenti che Mauro ha scritto sul suo blog Artigrafiche e, già che sei lì, mettere mi piace alla sua pagina di Facebook!
Per qualsiasi dubbio, curiosità, domanda, aneddoto, consiglio, abracadabra e altro scrivi un commento qui sotto, nel box dei commenti di Disqus!
Alla prossima,
Lorenzo.
Potrebbero interessarti:
	Pennelli di Illustrator: ecco a cosa servono (+ mega raccolta)
	Come scegliere il giusto tipo di stampa da usare?
	Una raccolta di più di 200 script per Adobe InDesign
	Le 4 tecniche di stampa che ogni designer deve conoscere




Lorenzo Miglietta









Registrati a Grafigata!
 Riceverai fin da subito: la Grafi-Newsletter (ogni giovedì alle 9 in punto con novità, tutorial e spunti sulla grafica), accesso alla community di Grafigata e tutti i contenuti e le risorse esclusive per gli iscritti. 

Oltre a tutte le funzionalità future di Grafigata che stiamo sviluppando.

 Iscriviti 

Commenti:

Ci sono 14 commenti in “Come esportare un PDF per la stampa”
	


						Paolo t. ha detto:

8 Luglio 2016 alle 11:38
Ok! La metà delle cose scritte in questo articolo non ne avevo la più pallida idea! Missà che mi devo studiare bene questi documenti di GWG, vero? ahah!

Comunque grazie per questo articolo!!

Rispondi
	


						Lorenzo Miglietta ha detto:

10 Luglio 2016 alle 13:47
Paolo dipende da quel che ti interessa approfondire come conoscenze secondo me :)

Se sei un designer che principalmente lavora in digitale (come me) ti “basta” avere qualche stampatore o punto di riferimento che ti possa aiutare in quelle situazioni.

Se invece lavori principalmente in stampa, allora sono tutti aspetti da conoscere e considerare.
Poi, ovviamente sta a te! :)

Rispondi



	


						LacunaInc ha detto:

10 Luglio 2016 alle 7:46
Ottimo articolo. Come sempre del resto! ;-)

Rispondi
	


						Lorenzo Miglietta ha detto:

10 Luglio 2016 alle 13:48
Sta volta è tutto merito di Mauro!

Ma grazie comunque!

Anzi, grazie doppio ;)

Rispondi
	


						LacunaInc ha detto:

12 Luglio 2016 alle 0:47
:D

Rispondi





	


						Mattia ha detto:

11 Luglio 2016 alle 6:53
Articolo molto interessante! :) mi ero sempre chiesto cosa fossero quelle voci sul menu a tendina…

Una curiosità: per generare un file di stampa ho sempre usato il metodo di creare un file postscript e poi usare Adobe Distiller per ottenere il Pdf… in tipografia non mi hanno mai segnalato nulla di scorretto.

Grazie mille.

Rispondi
	


						[ML] ha detto:

11 Luglio 2016 alle 14:22
Così facendo appiattisci forzatamente tutte le trasparenze presenti nel tuo progetto grafico, in quanto il postscript non supporta le trasparenze. In pratica equivale ad esportare un PDF con compatibilità Acrobat 4 (PDF 1.3).

Si tratta di un passaggio inutile, ricordati che se hai appiattito le trasparenze in fase di generazione del postscript, poi non potrai più riaverle indietro durante la conversione che fai con Adobe Distiller. Ti conviene esportare direttamente il PDF utilizzando una variante GWG adeguata. Se il tuo reparto prestampa è in grado di gestire PDF con trasparenze, puoi scegliere una variante GWG che le supporti nativamente. Ma ricordati sempre di scegliere le giuste variati GWG in accordo con lo stampatore !

Ciao.

Rispondi



	


						Typografreak ha detto:

16 Luglio 2016 alle 10:49
Gran bell’articolo ! Grazie mille. :)

Rispondi
	


						Lorenzo Miglietta ha detto:

17 Luglio 2016 alle 16:43
Grazie a te per questo commento! :)

Rispondi



	


						Claudio Senato ha detto:

7 Aprile 2017 alle 15:33
Ciao, mi chiamo Claudio. Grazie mille per l’articolo, mi è stato molto utile, ma sul link del GWG non riesco a trovare i preset per Illustrator, ci sono solo quelli per InDesign. Credo di non aver capito qualche cosa  :D

Rispondi
	


						Lorenzo Miglietta ha detto:

12 Aprile 2017 alle 7:59
Ciao Claudio!

Questo perché quando si prepara un pdf per la stampa, il procedimento “giusto” è quello di utilizzare InDesign :) I preset vengono costruiti quindi per InDesign essendo il software corretto per l’impaginazione!

Rispondi
	


						Lorenzo Miglietta ha detto:

5 Dicembre 2017 alle 15:12
Ciao Dario! Su Indesign è semplicemente più facile progettare per la stampa, gestendo in automatico cose come margini, ad esempio. Si può fare anche da Illustrator, certo,  ma con InDesign è sicuramente più pratico e permette un maggior controllo del progetto e del file.
La differenza è che usando i preset hai la certezza di esportare in modo corretto secondo determinati parametri :) Sono cose che vengono usate in ambito di stampa professionale ed è importante perlomeno conoscere di cosa si sta parlando!

Rispondi





	


						Claudio Senato ha detto:

6 Settembre 2017 alle 14:49
Ciao grazie ancora per l’articolo

Non so se posso chiederti consigli qui sulla sezione commenti.

Come faccio a sapere quale preset scaricare per il mio indesign? Tu hai scaricato SheetSpotHiRes_1v4, io dovrei  scegliere quale scaricare leggendo il documento della GWG che hai linkato?

Grazie mille

Rispondi

	


						BAF ha detto:

19 Maggio 2019 alle 8:24
Buon giorno.
Una domanda all’autore dell’articolo (o del sito): a me serve esportare un file docx come file pdf “stampa alta qualità” (opzione presente nel menù a tendina in “InDesign”, come ben sapete), non mi serve lo standard PDF/X. Il mio problema ― a parte l’attenzione d’avere già nell’impaginazione corretta del file docx, ecc. ―, è il non riuscire a caricare l’intero file docx (oltre 100 pagine) su “InDesign” (provato e riprovato, ma quando clicco col tasto destro del mouse, il testo non si rilascia, o al massimo si rilascia però solo la prima pagina e non tutte). Vi chiedo una mano, perché inizio ad avere dubbi se continuare con l’idea di usare “InDesign” (che resta il migliore per ciò che devo fare) o considerare altri programmi/soluzioni online per ottenere quel pdf. O riesco a caricare il file Word o devo trovare un’alternativa; ma quale?
Grazie e buona domenica

BAF

Rispondi
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